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2D Design 
1.1 Getting Started

When opening, Blueprint AV™ defaults to a 2D & 3D mixed mode workspace, using the Metric 
scale.  To change the unit of measurement to Imperial, click on the scale box.

Fig. 1

Fig. 2
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There are 4 main tabs in the Blueprint AV™ Workspace;

Room Data 

Create 2D or 3D room designs with Floors, Stages and 
Objects

Place virtual Adamson line arrays, subs, sub arrays or 
point source loudspeakers into your design

Run precise simulations to check your design before 
you deploy a system

View important rigging information for correct and safe 
array deployment.

Cabinet

Simulation 

Mechanical

Fig. 3

Fig. 4

Fig. 5

Fig. 6

1.1 Getting Started

2D Design 
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1.2 2D Design

To enter 2D design mode, go to the Tools drop down menu and select 2D mode.  The mode can 
also be entered by CTRL-F.

Fig. 1

Fig. 2

Fig. 3

To begin a 2D design, under the Room Data tab select Stage and add a new Stage by clicking the                           
         symbol.

In the pop up window you can name the Stage, assign the Stage to a Reference Axis, decide 
whether it will be activated for simulations, and set the following positioning data: mirroring, 
position on the reference axis, shape and dimensions.  

2D Design 
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1.2 2D Design

Once a Floor is created, individual Surfaces can be added using the          button

Fig. 6

In the pop up window you can name the Floor, select the Reference Axis, adjust the Color, 
Audience height and whether the Floor will be activated for simulations.

To add a Floor to the design, under the Room Data tab select the Floor tab and add a new Floor by 
clicking the          symbol.

Fig. 4

Fig. 5

2D Design 



Adamson Systems Engineering  |  Factory Training - Blueprint AV™ Module 1 Page 7Adamson Systems Engineering  |  Blueprint AV™ User Handbook

1.2 2D Design

This will add a new Quad Surface to the Floor.  There are 7 geometric Surface types available from 
the drop down menu, for 2D mode use the Quad Surface.

Surface type

Mirror and 
Center functions

Audience 
height 

Activate  
Surface

Coordinate 
input

Fig. 7

2D mode allows only 2 vertices to be edited, x being horizontal length of your Surface and z being 
the height.  

z = Height

x = LengthFig. 8

2D Design 
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1.2 2D Design

If Surfaces share a common vertex, data can be copied and pasted between surface by right 
clicking on the vertex input box to open the copy/paste menu.

Fig. 9

To learn more about 3D mode and the different surface types, see page 23

2D Design 
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1.3 Vertex Input Options

There are 4 modes of data input to set each floor vertex.  To switch data input options, navigate to 
the Options menu and select Vertex Input Option

The pop up window allows you to select between 4 different modes.  This chapter will cover the 
first 2 options:

Standard Coordinate is the default input method.  For 2D mode, vertex x and z coordinates are 
manually entered to design a Floor Surface or Object Surface.

Fig. 1

Fig. 2

2D Design 
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1.3 Vertex Input Options

The second option is a 2D calculator.  By defining a measurement point, a room can be measured 
with a laser distance meter and incline meter to set Vertex point for a Floor Surface.

To define a set point to measure from, enter x & z coordinates into the Distance-Angle From fields
eg:  If the lip of the stage was the 0,0 and the measurement was taken from 1m downstage at 
1.2m high, then coordinates x= 1.0 and z=1.2.  It is important to set the Distance-Angle From to 
ensure accurate room measurements. 

Once set, close the pop up.  The Floor or Object Surface vertex coordinate input fields will now look 
like this:

Distance Angle in Degrees

Fig. 3

Fig. 3

2D Design 
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1.4 Adding Virtual Arrays

Once the room design is complete, virtual loudspeakers can be added in the Cabinet tab.  Adding 
a Cabinet Group will bring up a pop-up window in which the Group can be named, Reference Axis 
defined, flown or stacked configuration set and Activation in simulation can be changed.

In the Cabinet Group, adding a Cabinet will add a loudspeaker source to the design.  Multiple 
Cabinets can be added to a Cabinet Group.

Choose a source type; Line Source, Sub, Sub Array or Point, then in Box Type, choose an Adamson 
Loudspeaker.

Source 
type

Box N  
(Amount of Boxes)

Mirror 
function

Source 
delay

Source 
gain

Polarity 
reverse

Box 
Type 

Box Angle 

Box Gain

Rigging frame configurationCabinet Group Rigging frame 
coordinates
and angles

Fig. 1

Fig. 2

2D Design 
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1.4 Adding Virtual Arrays

Add cabinets to the array by increasing the Box N field, manually entering a number or using the 
Auto Shoot option (See next page).  

To create a mixed cabinet array select the Box Type of the loudspeaker that needs to change from 
the drop down menu.  Once selected the Box Type below will change.

Fig. 3

Fig. 4
Fig. 5

Box Type Cabinet Type Box Type Cabinet Type
E15 E15 M SUB Metrix Sub

E12 E12 Y 18 Y18

E218 E218 Y 10 Y10 Paper

E219 E219 Y 10 K Y10 Kevlar

S 8N SpekTrix Y10 SUB Y10 Sub

S8W SpekTrix Wave S 10 S10

SP Sub SpekTrix Sub S 119 S119

M 8N Metrix E 119 E119

M 8W Metrix Wave

Box Type legend:

2D Design 
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1.4 Adding Virtual Arrays

Blueprint AV™ has the ability to Auto Shoot an array for fast and easy predictions.  To launch Auto 
Shoot, select             in the 2D cross section view.

Auto Shoot is used as a quick start in setting angles in an array. It is recommended that when 
dealing with multiple surfaces that angles and coverage be adjusted manually to meet exact 
coverage requirements.

Coverage start & end.

Auto Shoot predicts 
rigging frame height 

and angle.
User defined box count 
and Distribution  Factor

Auto Shoot predicts box 
count. 

Fig. 6

Fig. 7

Near Field Limit 
determines the start 
coverage of the array, 
duplicate of coverage 
start.

2D Design 

See  chapter 1.6  Fig 3. 
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1.5 Cross Section & Graphs

The 2 graphical displays on the right hand side have 5 selectable views to check 2D prediction data.

Cross Section:  Access Auto Shoot, View 2D coverage, vertical rays, distance to array bottom and 
start coverage

Distribution:  This graph shows the distance in relation to one another of where each cabinet’s 
focal point meets the listening plane. The green line is the Distribution Factor, which will change 
depending on the settings determined in the Auto Shoot function.  The Distribution Factor can be 
set ahead of time as well, with Auto Shoot attempting to match it.  Note that this may result in less 
initial coverage.

Fig. 1

Fig. 2

Fig. 3

2D Design 

Soft Directivity
Hard Directivity
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1.5 Cross Section & Graphs

GM Spectrum:  Shows a frequency spectrum response at a specific Guide Mark (GM) on the 
listening plane depending on the selected weighting.

SPL:  SPL coverage over listening area defined by the SPL weighting and frequency selected in the 
top menu bar (fig. 7)

Fig. 4

Fig. 5

2D Design 
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Vertical SPL:  A colored graphical view of the vertical SPL based on selected frequency and SPL 
weighting (Fig. 7).  To activate, select Calc in the lower right corner.  To view color scale pop up 
(Fig. 6.2) select the green button to the right of the display.

A max SPL can be set to achieve an intended target or if there are multiple sources at varying 
levels.  The range sets the colour resoloution shown incrementally from the maximum SPL value.

Blueprint AV™ simulations can be done in 4 different SPL weightings including Flat frequency 
response. The default is Y weighted.  Frequency response dictated by these different SPL weight 
can also be shown with the ability to view 2 different frequency responses simultaneously in the 
SPL tab (Fig.5) as well as 3D simulations.

In our experience, minimal dBA differences across a given space do not necessarily produce an 
even listening experience due to typical system high frequency distribution approaches.  These 
high frequency variances are small enough not to affect the overall dBA rating but large enough to 
be experienced by listeners across a given space.  While A and C weighted curves are available for 
use in Blueprint AV™, using the Adamson Systems Y weighted curve, which looks at all audio from 
2 kHz to 8 kHz, gives the user a far greater insight into how a targeted area will actually be covered, 
and how it will actually sound.

1.5 Cross Section & Graphs

Fig. 6 Fig. 6.2

Fig. 7

2D Design 
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1.6 Optimizing Arrays

When designing a loudspeaker system in Blueprint AV™, Adamson recommends the following 
optimization techniques.

Check individual frequency responses, as 2 individual frequencies can be displayed 
simultaneously.  ie: 8Khz to optimise inter-cabinet splay angles. 

Cross check A and Y-weighting SPL graphs.  An ideal design will have a 6dB corridor in both 
A and Y-weighted SPL. This ensures tonal balance throughout the intended listening area as 
demonstrated below.  

Fig. 1

Fig. 2

Fig. 3

2D Design 
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1.7 Mechanical Tab

The Mechanical Section contains two sub-tabs; the Mechanical Tab, and the Rigging Plot Tab 
(Rigging Plot not available in 2D mode)

The Mechanical Tab is comprised of three graphical displays; Cabinet, Frame Side and Frame Top. 

Dimension data as well as control parameters are shown on the left side of the screen.
Fig 2:
a) Display check boxes allow you to hide or show pertinent details on the display screens (Fig. 3)
b) Frame allows switching of rigging frame configuration to meet safety standards
c) Hanging type allows setting of amount and load limit of hanging motors
d) All pertinent coordinate and dimension data is located under Hanging Type.

a

b
c

d

Fig. 1

Fig. 2

2D Design 
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1.7 Mechanical Tab

Once the design has been completed a User Sheet can be printed to take to the rigging and audio 
team to deploy on site.
The User Sheet is located at the bottom of the File menu.  To edit the show/event, date and venue 
notes for the User Sheet select User Data from the option menu to launch the User Data pop up 
box (fig. 5).
The User Sheet will generate a PDF as shown on the next page.

Fig. 5

Display checkbox legend:

Rigging Alarm legend:

Dimensions Frame location, array bottom height, angles, rigging positions

Gravity Center of gravity, load weight of each motor point

Name Cabinet name

Compression Weight taken by each rigging link, compression between cabinet rigging

Overall Array length, width, lifting point distance

UH Load Under hang load for Y18/Y10

Small Alarm Only Changes hoist alarm from main page to small alarm next to checkboxes

Alarm Type: Cause: Solution:

Hoist Overload Array exceeds lifting capacity, Increase motor capacity or remove 
cabinets

No Tension on 
Hoist

One motor not taking any weight, 
unbalanced load.  

Change frame configuration or decrease 
frame angle until both motors take weight

Not Safe Configuration unsafe Decrease cabinets, change lifting or 
cabinet angles or increase lifting capacity

Fig. 3

Fig. 4

2D Design 
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ADAMSON BLUEPRINT USER SHEET

Show/Event: Blueprint AV Rigging

Event Date: 06/01/16

Venue: The Bridge
City: Rock City

Note: Excludes mirrors

Line Source: 1 (Main Hang)

Array Information

Installation Type: Flown
Hanging Type: 2 Motors
Frame: Short Beam Center For E-15

Lifting Frame Angle: -0.5°
Horizontal Angle: 0°
Top Side Angle = 2.5°
Bottom Side Angle = -18.7°

Total Array Height (incl. Frame) = 5 m
Total Array Depth = 1.2 m

Z Bottom Array Point = 5 m
Stage at 

Rigging Frame Position

Lifting Bracket 1: X = 0 m
Lifting Bracket 1: Y = 0 m

Lifting Bracket 1: Z = 10 m

Rigging Information

Hanging Type: 2 Motors

Total Weight: 1017.6 kg
Front Load = 414.3 kg
Rear Load = 603.3 kg

Distance Front/Rear = 1 m

Array Configuration

Frame: Short Beam Center For E-15        Lifting Frame Angle: -0.5°
Top Side Angle = 2.5°        Lifting Bracket 1: (0, 0, 10)

        #1 E 15 0 -0.5°
        #2 E 15 0 -0.5°
        #3 E 15 0 -0.5°
        #4 E 15 0 -0.5°
        #5 E 15 3 -1.9°
        #6 E 15 2 -2.5°
        #7 E 15 2 -3.1°
        #8 E 15 4 -5.1°
        #9 E 15 2 -5.7°
        #10 E 15 4 -7.7°
        #11 E 15 4 -9.7°
        #12 E 15 7 -15.7°

Bottom Array Point = (-0.6, -0.6, 5)        Bottom Side Angle = -18.7°
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3D Design 
2.1 3D Design Overview

Blueprint AV™ will always open in the last viewed configuration, so if you’re continuing from 
Module 1, change from 2D to 3D Mode by unselecting 2D Mode from the tools menu.

In 3D mode the right hand window will default to the 3D workspace, a 2D window is added to the 
bottom of the left hand editing window.

Above the 3D workspace some useful new buttons appear:

Fig. 1

Fig. 2

3D simulation 
controls

Top down 
view

Bird’s eye 
cabinet view

Vertical
rays on/off

Audience on/
off

Object 
on/off

Isometric
view

Rotate lock 
y

 Reference 
Axis on/off

 Parallel
Projection

Side view Rotate lock
x

Horizontal
rays on/off

Surface on/
off

Cabinet on/
off

Rotate lock
z

Stage
on/off

Export to 
DXF

Front view
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2.2 3D Surfaces

Stage 
To add a Stage, select the Stage tab under the Room Data tab.  Use the          symbol to add a 
stage.

In the pop up window choose a Name, Reference Axis, Stage Geometry and input dimensions

Activate for 
simulation

Choose reference 
axis

Stage position 
offset

Mirror functions

Stage type

Stage dimensions

Fig. 1

Fig. 2

3D Design 
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2.2 3D Surfaces

Quad
In the Room Data tab create a new Floor and add a new Surface, name the Floor and choose audi-
ence listening height.  The default Surface type is Quad, however in 3D mode access to all 4 vertex 
are available.  Surfaces and Vertices can be linked and the Surface can be centred or mirrored.

Arc Quad
The Arc Quad Surface has 4 vertices like the standard Quad but allows for 2 opposite edges to be 
arc’d by inputting a radius value in the r field and the height of the radius in the z field.

Surface mirror

Vertex Link

Edge Link
Centre Surface 

on x or y axis

Fig. 3

Surface mirror

Vertex Link

Edge Link

Arc edge radius
Arc edge heightCentre surface 

on x or y axis

Fig. 4

3D Design 



Adamson Systems Engineering  |  Blueprint AV™ User Handbook Page 24

2.2 3D Surfaces

Triangle
A 3 Vertex, 3 edge Surface.  

Arc Triangle
A 3 Vertex, 3 edge Surface with the ability to add a radius to one edge as well as radius height.

Fig. 5

Fig. 6

Arc edge radius
Arc edge height

Edge Link

Edge Link

Vertex Link

Vertex Link

Surface mirror

Surface mirror

Centre Surface 
on x or y axis

Centre surface 
on x or y axis

3D Design 
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2.2 3D Surfaces

Circle
A circular Surface with adjustable points for radius and how many sectors the radius will be 
broken into.  The centre of the Circle can be placed in the design by entering in x, y or z  
co-ordinates.

Fig. 7

Radius Control

Reset to Centre of 
reference axis

Position of the 
circle centre 

Surface mirror
Centre Surface 

on x or y axis

3D Design 
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2.2 3D Surfaces

Extrude
Extrude can be used to quickly create multi-level Surfaces.  Up to 6 points can be made for a total 
of 5 Surfaces.  The direction drop down defines the direction of the extrude to be either left or right 
from the extrude vertices or centred.  The Dim Top and Bottom define the width from the centre of 
the Extrude.

Width of Extrude 
from direction

axis Extrude vertex input 
and link

Extrude edge link

2D view and click 
and drag to move 
points manually

Extrude explode
creates multiple 
quad surfaces

Extrude point selection Extrude width directionFig. 8

Fig. 9

Surface mirror
Centre Surface 

on x or y axis

3D Design 
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2.2 3D Surfaces

Revolve
The Revolve Surface is used for creating multiple layered curved Surfaces.  Revolve edges can be 
linked drectly to Extrudes and left and right vertices can be linked to other Surface types.

Fig. 10

Fig. 11

Vertex link

Revolve point selectionCenter on x axis
Revolve angle Surface width direction

Edge link

width of front or 
rear chords

Revolve 2D view

Surface mirror
Centre Surface 

on x or y axis

3D Design 
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2.2 3D Surfaces

Linking surfaces
In 3D mode, most Surface edges can be linked together using the           button or link buttons.
When an edge is set to link, hover the mouse over the surface you wish to link to.  The edges of the 
surface will display a white dashed line, move the mouse to the desired edge until it’s line becomes 
a solid white line and click to link.  Note that linking a Surface to another means the first Surface 
will take on the characteristics of the second Surface.

Linking vertices
In 3D mode vertices can be linked easily by selecting the Vertex link button            then using the 
mouse to select the Vertex in the workspace.

Fig. 12

Fig. 13

Selected Vertex will magnify 
slightly when selectable

Solid white line shows edge 
selected to be linked 

3D Design 
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2.3 Objects

Objects are useful for creating Surfaces that do not need to be included in a simulation, ie: 
proscenium arches, underbalcony ceilings or FOH/spot towers.

Objects are created in the same way as Floor Surfaces with the addition of 3 extra Surfaces in 
place of the Extrude and Revolve; Quad Block, Triangle Block and Polygon.
The Quad and Triangle block objects are solid 3D objects, the distance field defines the height 
from the 4 vertices on the z-axis.

Fig. 1

Fig. 2

Surface mirror
Centre Surface 

on x or y axis

Vertex link

Edge link

Object shape 
selection

3D Design 
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2.4 3D Array Design

Line Source
Virtual arrays can be added to a 3D design in the Cabinet Tab as in Chapter 1.5.  Every new array 
added is always placed at 0.0 on the y axis.

Set array beam option* Lifting frame horizontal position
Lifting frame vertical positionSet the location of the 

downstage rigging 
position

*The beam option affects the array position

Fig. 1

Fig. 2

3D Design 
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2.4 3D Array Design

To create a L+R array, set the y position of the array and if the design is symmetrical, mirror the 
array on the x axis.  Changes made to either array will affect both providing they are kept mirrored.

The process can be duplicated to add outfills, 270 or delays.  

Fig. 3

Fig. 4

Cabinet mirror

3D Design 
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2.4 3D Array Design

Sub
Selecting Sub from the Cabinet drop down will place a single sub or a stack of subwoofers in the 
workspace.  Choose subwoofer type and increase the stack by increasing the Box N.  The Preset 
drop down allows for cardioid presets to be added.  Choose from End Fire, Front-Back or Front-
Back-Front.  Engaging these presets automatically adds the necessary cabinets needed for 1 unit 
of this preset. Changing the Box N when a preset is engaged will double or triple the subwoofers 
needed.

Sub Array
For complex sub arrangement, using Sub Array allows for multiple columns with the ability 
to space, center and place as well as individually adjusting column delay, polarity and gain for 
simulation.

Fig. 5

Cabinet type

Sideways rotation

Cardioid presetSub location

Horizontal & 
Vertical position

Fig. 6

Define either span 
or space between 

columns

Adjust individual 
column placement

Cardioid preset

Center columns 
on y axis

Offest all columns 
at once

Sub Array edit

Add columns

3D Design 
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2.4 3D Array Design

Point
Selecting Point from the array drop down will add a single point source speaker to the workspace.  
Each Point Series cabinet can be either flown or ground-stacked, as well as mirrored, delayed and 
have its gain adjusted individually.

Fig. 7

Fig. 8

3D Design 
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2.4 3D Array Design

Rigging alarms
When adding virtual arrays to Blueprint AV™, if an unsafe or impossible rigging option is selected 
an alarm will show in the 3D workspace.  If a red box surrounds the 3D work space, check rigging 
frame options, inter-cabinet angles or rigging hoist load restrictions in the mechanical tab.
For a list of rigging alarm types refer to the Mechanical Tab in chapter 1.8 fig 4.

Red line indicates
rigging hoist alarm

Fig. 9

Fig. 10

Display option

Frame configuration

Motor point options

Array position and 
weight

3D Design 
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2.5 Simulation

It’s important to check array coverage before deployment.  In 3D mode, the 2D SPL graph is still 
viewable below the array editor.  This is important to check when adjusting inter-cabinet angle as 
shown in module 1. SPL simulations are covered here, refer to section 3.4 for Advanced SImula-
tion options.

3D simulation for all listening surfaces can be calculated by clicking the draw button at the top of 
the workspace.

2D cross section and SPL simu-
lation data available in 3D mode

Fig. 1

Fig. 2

Draw 3D simulation

Hover mouse or 
click for scale

Swap 3D with 2D 
cross section view

3D Design 
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2.5 Simulation

Hover on the scale button to view the 3D SPL scale.  The scale window allows saving of 8 snap-
shots, the SPL bubble grid size (default is1.5m), high resolution, setting a max SPL, adjusting the 
scale range and to calculate interference between arrays.  Changing the SPL weight in the top 
drop down menu will require the simulation to be re-drawn to take affect.

The simulation tab offers more advanced simulation options.  Under the SPL tab cabinets can be 
individually deactivated to be excluded in simulation data.  Cabinets, Floors, Stages and Objects 
can also be deactivated. Select group and uncheck the Cabinet, Floor, Stage or Object to be ex-
cluded from simulation.

Fig. 3

Fig. 4

Pin to workspace

Snapshot storage

Simulation grid size in meters
High resoloution smoothing

Define max SPL
Define SPL scale range

Show multiple source interference

3D Design 
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Advanced Design Tools 
3.1 Reference Axis

Reference Axis sets the zero point for the x, y & z of a design, giving a defined point to start 
designing from.  Blueprint AV™ allows for multiple reference axes to be set in a single design 
project, useful for adding multiple Stages, Cabinets and listening areas to create large festival 
grounds or even multiple configurations of popular venue.

In the Room Data tab, select Ref Axis, a default “main” reference axis is set for each new design.  

To create another Reference Axis, click the       button, name and set the starting location of the 
new Ref Axis based on the main Ref Axis by defining the x or y, center and or set horizontal angle.

Reference Axes can be linked so when one is moved the linked axis will move in unison to the new 
x, y position.
Centering a Reference Axis will center the new axis with the main Reference Axis.
X, y and angle define the orientation of the new Reference Axis.

Add, Copy or Delete
Select Ref Axis

Name

Select location of 
the Ref Axis

Select location of 
the Ref Axis

Update

Fig. 1

Fig. 2
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Advanced Design Tools 

3.2 Vertex Input Option

In Blueprint AV™ V1.0.4 and up, Vertex Input Options were added as a powerful tool for entering 
venue data quickly on a site survey.  There are 4 options for data entry, switching between input 
options will retain all dimensions and angles.

Standard coordinate entry is the default input option 
and allows for x, y & z dimension input.

2D Calculator is for use with distance and incline 
measurement tools.  Coordinate input fields are; 
distance, y and vertical angle.

3D Calculator is for use with distance and incline 
measurement tools where the horizontal angle can 
be protracted in degrees.  Coordinate input fields  
are; distance, horizontal angle & vertical angle.

Fig. 1

Fig. 1.1

Fig. 2.1

Fig. 3.1

Fig. 2

Fig. 3

Enter the position of measurement tool

Enter the position of measurement tool.
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3.2 Vertex Input Option

Standard + 3D is a hybrid entry method combining 
the 1st and 4th options.

Fig. 4

Enter the position of measurement tool.

Advanced Design Tools 
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3.3 Command Line

There are a few useful function of Blueprint AV™ that are accessible from the lower workspace 
window or the Command Line below.  Typing the name of the button will achieve the same result.

The Command Line section can be used for manually moving, rotating or copying Floors, Objects 
or Cabinets. Type a command followed by enter/return.  To cancel any command press esc to re-
initialise the terminal.  Ctrl-z or ctrl-y also undo or redo.

Example:
> Type “copy”
> Select a floor surface and enter
> Select first point or enter x,y,z 
coordinates, press enter
> Select second point or enter 
x,y,z to move , press enter
> Select yes, copy done

Fig. 1

Fig. 2

 Distance & Time 

Command Line 

Move By

Copy

Rotate

Array
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3.3 Command Line

Distance/Time is used to measure the distance between 2 points and displays length and time in 
your specified scale as well as milliseconds.  This is useful for finding delay times between Cabi-
nets and is used to input delay time for Virtual Mics.

Move by allows the user to move a floor, object or cabinet between points.

Copy Floor, Object or Cabinets

Example:
> Select        , follow prompts in the 
Command Line: 
> Select first point, enter
> Select second point, enter
> Pop up window with data

Example:
> Select        , follow prompts in the 
Command Line:  
> Select first point, enter
> Select second point, enter

Example:
> Select        , follow prompts in the 
Command Line: 
> Select first point, enter
> Select second point, enter

Fig. 3

Fig. 4

Fig. 5
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Rotate Floors and Objects

Many of the functions listed in section C are also accessible by right clicking in the workspace, 
activating a drop down menu.  The menu varies between the Room Data, Stage, Floor and Object 
tabs as well as the Cabinet tab as shown here:

6. Array, like the AutoCAD function, allows for a Floor, Object or Cabinet to be arrayed on either 
axis.

Example:
> Select        , follow prompts in the 
Command Line: 
> Select Surface(s), enter
> Select rotation point, enter
> Select rotation axis (default is z), enter
> Define angle 
> Keep or discard original surface (Y/N), 
enter

Example:
> Select        , follow prompts in the 
Command Line: 
> Select component, enter
> Select direction (default is z), enter
> Define end result number
> Define distance between each 
component

Stage & Ref Axis; right clicking in the 
workspace will bring up the following 
menu.

Fig. 6

Fig. 7

Fig. 8 Fig. 9

Ref. Axis Stage
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Fig. 10

Fig. 11

Fig. 12

Select a floor or object and right click in the 
workspace to bring up the following menu.

Select a cabinet and right click in the 
workspace to bring up the following menu.

Floor Object

A full list of Command Line shortcuts and shortcut keys can 
be found in the Help menu.

3.3 Command Line
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3.4 Advanced Simulation

SPL is the default simulation.  SPL calculates data using the global weighting and frequency 1 in 
the top menu ribbon.

The Simulation Tab offers 5 different types of simulation data.  Each tool is useful for predicting 
the outcome of a design before deployment, cutting down valuable and often costly onsite work.  
Simulation Data in this tab are only available in 3D mode and can be drawn from the 3D work-
space.

First Arrival Time calculates multiple time arrival differences within a 6 or 10dB threshold.

Fig. 1

Fig. 2

Advanced Design Tools 
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3.4 Advanced Simulation

Δ (Delta) Time allows users to see off-axis time alignment between two arrays as it falls within 
Haas Effect parameters within a 6 or 10dB threshold

Directivity calculates 0-6dB of summation between sources, providing an idea of stereo imaging.

Fig. 3

Fig. 3
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3.4 Advanced Simulation

Virtual microphones provide a representation of how a measurement will appear based on IEC 
peak values with global weighting applied.

Note: Measurement is based on a flat cabinet response (no preset data), to be used as a reference, 
showing the difference between two or more positions on the listening plane.

Fig. 4

Advanced Design Tools 
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Introduced in Blueprint AV™ V1.0.4.2 objects can now be set to block sound along with what 
frequency bandwidth the blocking will effect.

Below is an example showing a Quad Block in the listening field showing the potential dead spot 
in SPL from a FOH tower.  Object blocking simulations will take longer than regular 3D simulations 
due to the increased calculations performed by Blueprint AV™

Fig. 5

Fig. 6

Fig. 7

3.4 Advanced Simulation
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Blueprint AV™ has several export options, room, object and cabinets can be exported to be 
imported into new projects, and an entire project can be exported to DXF for using popular CAD 
programs.

Room designs can be imported or exported from the file menu.  Ex-
porting a room will save all floor, object, stage and reference axis in a 
single .rm file.

Fig. 2 shows the a blueprint design on the left and the DXF in AutoCAD on the right.  
The DXF export layers for CAD programs are by default:
Layer 1: Cabinet
Layer 2: Stage
Layer 3: Floor
Layer 4: Object

Export to DXF will take all floors, objects, stage and cabinets and 
create a scale drawing for autoCAD, Sketchup or any other popuar 3D 
drawing software.

Fig.1

Fig.2

3.5 Design Export
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Fig. 3

Fig. 4

Fig. 5

Individual Floors, Objects and Cabinets can also be imported or exported in their edit windows. 

Floors can be exported 

Objects

Cabinets

3.5 Design Export
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